Zedmed v36.6.0

Last Modified on 10/02/2025 1:41 pm AEDT

Upgrading to this version will provide the following updates.

NEW Referrals Expiring Report

This report allows the practice to see expiring referrals by Date, Practitioner and Appointment Type and send SMS notifications to

patients regarding their referrals. Learn more.

NEW Schedule conflicts preview

When adding or editing a schedule, you can now view conflicts on a dedicated pane, making it easier to review all conflicts and their
details in one place. Learn more.

NEW Billed status in the Appointment Book
A $icon (see screenshot) will now appear in the Appointment Book next to patients who have been billed. The billed icon is part of the
following sequence of status icons: File Pulled > Attended > Billed.
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NEW ATSI status in Clinical
The ATSI status in the patient's record is now reflected in Clinical with icons.
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NEW Drugs Module without MIMS
Zedmed's Dugs module can now be used to create prescriptions without MIMS.

Office

ZED-8825

Scheduling error messaging for better feedback to users

Conflicts that arise for changes to Appointment Schedules are no longer shown in a popup window but are now
displayed as part of the Schedule Setup screen. A new Check for Conflicts button enables changes to checked as they
are made.

Office

ZED-8859

Create a new report "Referrals Expiring Report"
A new report is available in Office to show patients with upcoming appointments for which their referral letter has
expired. The Referrals Expiring Report can be found in Management > Reports.

Office

ZED-8899

Add a Billed symbol to the appointments screen once a patient has paid/been billed
Zedmed Office now displays a billed icon on the appointment screen after a patient has been admitted and billed.

Office

ZED-8940

On Patient Details Other Contacts set default phone number to Mobile
Next of Kin and Emergency Contacts now default to Mobile Phone rather than Home Phone in Patient Details.

Office

ZED-8952

Dr Name merge field not working in SMS reminders when a title is not specified
Scheduled Appointment Confirmation, Reminder and Recall messages that include the Doctor Name merge field
now correctly include the Doctor's Name for a doctor who does not have a Title specified.

Clinical

ZED-8836

Prevent failure to load HealthLink forms when one of the HL7 files cannot be loaded
Issue that caused failure while loading HealthLink Forms if an HL7 file is corrupted has been fixed. Now forms will be
loaded even if a corrupted file was detected. Corrupted files or data parts will be skipped.
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Zedmed APl issue - An Invalid Connection String Argument
Clinical | ZED-8870 | Theissue that caused the “An Invalid connection string argument” error during the MIMS update check or when
prescribing electronically has been resolved.
Validate Email and mobile data entered into the Address book
o Zedmed Clinical now validates the email and mobile phone fields when creating or editing a contact in address book.
Clinical | ZED-8872 The email entered must conform to "user@hostname" pattern, whereas mobile phones must be 10-digits long
(without spaces), or up to 12-digits long (with spaces) and begin with "04".
Disabling use of MIMS as a database does not allow to use Drugs Module
o Added the ability to use the prescribing module in clinical without having MIMS installed. Un-check the "Use MIMS
Clinical | ZED-8855 for Medication Database" option in the Drugs tab of Global Options Note that only recipe drugs will be available to
prescribe.
Save column order not working in My Options
Clinical | ZED-8894 | Zedmed Clinical medications dialog will now remember user-specified grid column order and widths on the "Existing
Drugs" tab page.
. Add ATSI status to the patient demographics
Clinical | ZED-8897 | A patient's ATS! status is now displayed graphically in the Patient Details screen within Clinical.
. Change the pregnancy shortcut key from ctrl-B to something else that is available
Clinical |ZED-8908 The keyboard shortcut to open Encounter > Pregnancy module has changed from Ctrl-B to Ctrl-Alt-B.
Current/Resolved problems move arrow not enabled when moving to next item
Clinical | ZED-8910 |Fixedissue thatrequired an extra click away from the list to re-enable the arrow to move problems from Current to
Resolved or vice versa.
Uncheck authority if private is selected as PBS Status in Prescription Script details
Clinical | ZED-8912 |When prescribing a Drug with a PBS Status that requires an Authority, if the status is changed to Private, the
Authority checkbox is now automatically cleared
Global options Max file upload size text box is incorrectly displayed on all tabs
Clinical | ZED-8944 |A cosmeticissue has been fixed on Clinical global options dialog where the max file upload size edit field would
continue to display on all tab sheets.
Letter Writer - Insert > Today's Notes inserts the text with incorrect formatting
Clinical | ZED-8953 | When "Todays Notes" are inserted from the Letter Writer in Clinical the notes no longer contain additional blank
lines.
Fix buttons displayed on allergies message box question
Clinical | ZED-8980 |Whenchanges to a patient allergy are about to be inadvertently lost, the confirmation message box now displays Yes
and No buttons rather than Yes and Ok buttons.
Zedmed v36.5

Upgrading to this version will provide the following features and updates.

To assist with the adoption of these new features, see theZedmed v36.5.2 checklist.

NEW Electronic signatures
Electronic signatures can now be added to letters and referrals by applying the 'signature image' merge field. Simply save the
practitioner's signature as an image file and upload it to their profile. Learn more.

NEW Secure Send
Secure Send is a feature that uses email or ZedSMS to send invoices, documents and referrals (including radiology and pathology
referrals) to the patient or payer using a link to a secure download. Learn more. To enable Secure Send, submit a request form.

NEW Automatic recall reminders

SMS recall reminders can now be scheduled to go out automatically using the same process as scheduled appointment reminders in
Zedmed's SMS Configuration console. Learn more.
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NEW MyMedicare support

MyMedicare is a voluntary patient incentive scheme designed to formalise the relationship between patients and their practitioners.
This update adds support for the MyMedicare bulk billing incentive items, and the ability to record and display a patient's
MyMedicare registration status in Zedmed. Learn more.

Resolved Error: Cannot Reconcile Patient - Duplicate Message_ID
Office ZED-8766 | Fixed an error that could occur when performing a provisional patient merge. This error would occur when the
patient already exists in Zedmed and replies to an SMS before the patient reconciliation occured.
Resolved an Error that appeared when adding a patient to an appointment from the waiting list.
Office ZED-8767 |Fix anerror that occurred when adding a patient to an appointment using the cancellation waiting list - if an
SMS reminder had already been sent for the existing appointment.
Resolved Error Code 400 when creating a Doctors App QR Code.
Office ZED-7765 | Fixed an error that could occur when creating a Doctors App QR code in Zedmed. The code is scanned by a
user to enable to app on their device.
New Medicare Plus Incentive items
A notification will advise if New Medicare Plus Incentive scheme items are available to the patient during
billing. This includes the new MyMedicare incentives.
The following billed items qualify for Medicare Plus Incentive items.
Click 'Add Items’ to automatically add the ticked items to this invoice.
] ::;:;me Items Description
Office | ZED-8794  10990(25/10/2023) 23 for service item of Group Al of Category |
bontass
Office & Removed the Zedmed Clinical Service and the Zedmed HI Service
ice
Clinical Zedmed's software no longer uses these 2 services. Their functions have been incorporated into the Zedmed
inica
API.
Clinical | zED-9106 Resolved error "Is not a valid integer value" when trying to distribute letters from batch writer
inica -
This error occurred for patients who had a referral that was created in Office > Patient Details
. Access violation on Secure Send
Clinical | ZED-9076 | _. L. . .
Fixed an access violation that could occur if that patient has no account payer
Fixed the Results Inbox sort order
Clinical |ZED-8978 | The Results Inbox now sorts the results correctly when sorting by the Result Reported Date when you use Get
all Results for a Patient button. The Result Reported Date is the date of collection/testing
. New Radiology referral template: iMed Radiology Imaging Specialist
Clinical |ZED-8589 . L . . . I
The Radiology-MedReferralSpecialist request form is now available as a Radiology Form in Clinical.
Clinical | zED-8881 New Radiology report template: iMED Radiology - Myocardial perfusion imaging request
ini -
The report template Radiologyl-MedMyocardialPerfusionlmaging is now available in Clinical.
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The red lines in Zedmed's modern Ul option can be changed to grey
Added the ability to change the red lines separating each section in the Clinical Ul to grey lines. This is changed
in Clinical Tools > My Options > General tab under Line Colour: Red/Grey.

Show |Last 10 Consultations » | I History View Use Chronic Disease Module
Clinical |ZED-8702 || Deaurrempisee e ] | F5, 7 Ono @ sie Detoun
Document Template |R:1 Letter - Standard P | Clear
. Y bon Timer Al
Themes Line Colour Consultation Timer Alert
O Classic (® Modern @ Red O Grey [Juse Consultation Alert | B2ep at End Time
Address Book L g5 -
OA}k Ewery Time @ Zedmed O HealthShare
? Help ok X cancel

Removed Measurements from the Clinical document writer's Details Merge fields
Clinical |ZED-8728 |Removed the outdated "Measurements" merge field from the Clinical document writer's template tools. The
"Measures" merge field should be used going forward.

AIR Update - New mandatory field: Vaccine Type (Regulatory compliance update)
Added a new field mandatory field called Vaccine Type that will be required for government compliance in

March 2024, and expanded the Route option descriptions.

Immunisation X
Doctor
Branch: Albany Road Clinic w [ Mot Given Here
Name:  Phillip Davis v Administered Overseas

Immunisation Details
Brand/Vaccine: l l] Manual..
incude non-AIR vaccinations
Clinical |ZED-8802 Date Given: [10/01/2024 i
Dose: Schoal ID: Required only if immunisation
administered at a school

Batch Number: ~| [ store Batch No. (available from the ACARA
~

Australian Schools List)

Site: |
Route: [ ]intramusculas [ ] Subeutaneous [ ] Oral [ Intradermal
I Vaccine Type: [ ] Antenatal CINIP or Commonwealth [ ] Private || State Program ]
Comment: | |
Add Recall o oK X cancel
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Send directly to pharmacy option for electronic prescriptions (Regulatory compliance update)

On the Electronic Prescriptions screen, there is now a "Send directly to Pharmacy" checkbox with a reasons
drop-down. This option will print out a QR code (token) for the prescription that can be faxed or scanned then
emailed directly to the pharmacy. This is for compliance with state and territory legislation that prevents
prescriptions from being given to patients for specific controlled substances.

Flectronic Preseription

Dr Fhilin Gavis RACGH
Eranch 1

Lewed 3, 50 Albert Road
SOUTH MELBOURNE 3205
Prescriber Mumber: 3577773

Phane Humber: 03 9264 3300

| Motes for pharmscist [staged suppdy, special approval, specdic condibian, ete).
NOTE: may be visible Lo patient.

L

1,_

Fatient's Mame Ms Marrianna | oulse lones Fatient's Medicare ITBOIIETHY
Address 6 Janes Pl
GOWRIE 2804 Fhamaceutical eretits entalement Raute of Adminstration =]
number
Date of Birth  19/05/1967 FES SaftyMet  []  Concessional or dependant (] Clinical Indication -
entitlement card RPES benehicary or PES Satety
Date 0370147024 halder et card halder
Minimim Repeat intersal [cays) |
CIiniCaI ZED_8781 FES [ @Pes []  Evand substitutions not permitted ] _— B
arcant number
Rosuvastatin Smg Coated Tablet 5mg [30] sl Dase
PUFF
[ ] Seript s tor urgent supply |seript owing)
Qty: 1730 5 repeats
Electronit Preseribing Taken delivery
O (06997730
CEmail |
(Mo Electronic Token
(I Print Paper Token
B Unioad seript to Active Script List
[)5enc prescription cirectto Pnarmacy  Reason: | Desing ol -
The aption sbove will prevent the palient from receiving the Loken, It is intended thal the paper Loken
36 piied and prouiced dreety tn fhe pharmacy.
This is due be & requinement in indnicual stale and teritery legisistion thal prevents prescriptions frem
being handed aver to the patient for specific controlled substances.
_ J
B Prescribe Bectronically | Cancel
Dosage information is now mandatory for all prescriptions (Regulatory compliance update)
Prescribing now requires dosage information in the Dosage Full Text field. This is a compliance update for
electronic prescribing that has been applied to all scripts.
a5
Atenolol 50mg Coated Tablet 50mg [30]
You selacted: Atenolol 50mg Coated Tablet (Tablets] S0mg [30]
Dosage Frequency MIMS
capsuls [atter meals A\, The MIMS information displayed below is of product “Atenalol REX Tablets Somg (307", this
Halt a drop | as directed infarmation may vary for other praducts/brands with the same generic name.
puff | as needed
1 2 | 3 | taviet |8t night SN Bostne :
2Ztimes a day | before meals Admin > 100 mg/day as divided dase. Hypertension: initially 50 mg/day; may incr by 50 mg/day every - |
1 3times a day | in the morning wik to max 200 mg/day. Angina: initially SO mg/day; may incr to 100 mgJday. Arthythmia
4 | 5 || 6 ||+timesacay maintenance: 50-100 mg/day. Mi maintenance: 50 mg/day for 1-3 yrs. Initiate after early intervention
every 4 hours with other agents or immediately if patient presents > 12 hrs post-ML. Renal impairment. CICr 15-35
every 6 hours mL/min: SO mg/day or 100 mg on altemnate days; CICr < 15 mL/min: 50 mg on alternate days or 100
7 8 -] once a day mg every 4th day, haemodialysis: 50 mg after dialysis. Elderly consider dose reduction. Withdrawal:
A weekly reduce gradually over 8-14 day:
ar | o | oo
Clinical |ZED-8840 | Dua Use .
Error x all grades incl renal origin; frequent disabling angina
Caleulater arrhythmia; MI {late intervention) (> 12 hrs after chest pain
Dosage infr - for use) mustbe d in arder
to preseribe. b

¥ Undo | | C4Redo | | Clear
(®) Regular Use (O PRN
Quantity [1°30 | Repeats |

Seript Date:  [19/12/2023 |

(D) Short Term

| P85 does not allow repeats

PPBS Status
= S / RPES

[JHice from display (archive) if not current  Medicine estimated to last until I}.a.m_-;l:-y = ® private Pes /RPES  ORPES pes O seation 100
b/l Upload script to Active Seript List Warn me to renew script after [09/01/2024 | Re Include Brand on Scaipt
&} [osion T [regaa

[ Authority Brand Substitution NOT Permitted
Drug Motes

1
|Add to encounter notes
MIMS P, MIMSCJL | T7 Add Favourite  Add to History | [ Preseribe ﬁeﬂmnbﬂlb’l | o Prescribe X gancet
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OLA

ZED-8650
ZED-8649

New Practitioner ID option as an alternative identifier for Online Appointments.

Zedmed can generate a Practitioner ID so a doctor can be set up for Online Appointments. This is ideal for
treating doctors without an HPI-I. The Practitioner ID is assigned in the doctor Details screen, along with the
Available Online setting for OLA.

Clinical Settings
Qualification |MBES 3

Details Hew

Status

(TR L
[ availaple [ Assist Only Hvailable |

r
Prescriber No |
Online_;

u External Primary EI
Surgeon Only

Email Address I
ECLIPSE Fund Schemes [[Jshow Code on Appt. Screen

Online Appointment System Text for specialty treatment

Practitioner 1D
[65201FAD- 1 Generate

Signature Image

OLA

ZED-8654

Patients must now choose an appointment type in Online Appointments

Online Appointments no longer has a default appointment type. Patients must select an appointment type to
create a booking, ensuring they book for the intended appointment type. This prevents patients from booking
the incorrect appointment type and allows you to only give new patients a new patient appointment type.

What type of appointment are you
booking today?

[ 5td Consultation l I Review Consultation I

&

Zedmed v36.3.4

Upgrading to this version will provide the following updates.

o Resolved Error: Item not found when closing a patient file in Zedmed Clinical.
Clinical | ZED-8867 This error occured when opening a patient in Clinical from Office, if Clinical had not been shut closed properly.
. Resolved Error: List Index (1) out of bounds.
Clinical | ZED-8886 This error also occured when opening a patient in Clinical from Office, if Clinical had not been shut closed properly.
o Resolved Error: Unsatisfied constructor on type: MyHealthRecord.Conversion.TMhrDocumentView.
Clinical | ZED-8865 The error occurs when trying to view a result that has been added to the summary view from My Health Record.
Resolved Issue with Zedmed Upgrade file v36.3.3
Upgrader | ZED-8882 | The error prevented some users from upgrading.
Zedmed v36.3.3

NEW HealthShare integration

The Clinical Address Book is now integrated with HealthShare so practitioners have access to Australia's most used Specialist and
Allied Health directory for letters and referrals. This feature requires internet access. Learn more in our HealthShare guide.

NEW Intramail search
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There is now a search option in Office and Clinical Intramail so you can search your inbox and sent items for mail using the sender's
name, subject, date range or a linked patient. Learn more in our Intramail guide.

NEW Editor for Office templates

For customers who do not have Microsoft Word, we have added a Zedmed RTF editor so you can create custom Office templates.
This is useful for on-premise customers moving to Zedmed Cloud. Learn more in our new Office templates guide.

NEW Banking Report enhancements

10 updates to Zedmed's banking reports to improve clarity and consistency.

Office

ZED-8409

Support has been removed for 3rd party SMS providers

Support for "SMS Everyone", "Inspirus" and "Other"(generic) SMS providers has been removed. ZedSMS
replaces these providers for the sending of SMS messages from Zedmed.

Office

ZED- 8832

ZedSMS performance updated
The ZedSMS SendPoint was updated to improve the send and receive speed of SMS messages.

Office

ZED-8466

ZedSMS Purchase Link updated

Updated link to purchase credits for ZedSMS due to the change in supported providers. It now points to the
ZedSMS Message Centre.
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Banking Report enhancements

reflect the data presented more accurately.

The following enhancements have been made to Zedmed's Banking reports:

e Removed unused HealthPoint sections from bank reconciliation, deposit & session reports.
* Widened the payer name column On behalf of to accommodate longer names.
e Renamed the 'Bank Reconciliation Report' heading fromReversals to Cross-Session Reversals to

Batches
Closed On Batch # Cash Cheques MC Chq Cards Total EFTPOS
23-Jun-2023 4 21330 0.00 270 10675 341335 4212.49 142 60
Totals 21330 000 270 10675 41335 4,212,483 142 60

HealthP oint

0.00

Totals 0.00
Direct Deposits
Date Paid by Bank Branch Details On behalf of Pay Date Amount
01dun2022  Medicare Reserve Canberra Dr Jackson Medicare 13245

e Updated the Bank list label to say, Show Inactive Bank Accounts (previously 'Show All Bank').
o New page on staff change checkbox is now only enabled if Group by staff member checkbox is ticked.

Banking Reports

Bank Deposit screen or the Print/Close Session screen.

Office ZED-8418 Style
(®) Batch Details
Batch Number | <Current Batch>

OSession Dretails
Session Number | 34 Started On 15/03/2023 9:22:19 AM

OReconciIiation Report

From [o1/112023 A|F T [onuv22 2|F

Print Screen Export

Use this screen to print reports on previous and current batches and sessions. If you want to close a batch or session, please use the

To ensure this report includes all transactions from all other workstations, it is recommended you exit from all
instances of Zedmed Office running on this workstation and log in again.

Criteria
Banklist [Dshowlnacti\re BankAccount]
| Albert Road MC Bank Account v

D Group by staff member

Mew page on staff change

Test Branch 1 FDAVIS

staff changed' was selected.

payment enquiry form.

e Fixed anissue where payments by staff would not print on separate pages if the option 'New page on

e Fixed anissue to prevent using the same reason text for all reversals made without closing the
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Resolved an issue with the inclusion of cross-session reversals
The Banking Batch Details Report now takes into consideration any cross-session reversal transactions in
the overall totals section of the report.
Session Totals Overall Total 71.30
Cash 71.30 Credi Card 000 Cheques 0.00
Direct Deposit 000 EFTPOS 0.00 Medicare Cheques 0.00
HeathPoint 000
Office ZED-8445
Banking Session# 2
Banking Session# 6
rCrou—t‘-‘;e“ion Reversals
2100712023 2 Black, Emma -7.30
L W rong pay ment in difierent ses
Report Totals Overall Total 71.30
Cash 7130 Credit Card 0.00 Cheques 0.00
Direct Deposit 0.00 EFTPOS 0.00 Medicare Cheques 0.00
. Changed the Banking Reconciliation Report date format
Office ZED-8463 . oo .
The Banking Reconciliation report now consistently uses "dd/mm/yyyy" as the date format.
. Changed the date format for Reversals on banking reports
Office ZED-8500 Rk R . ., .
Reversal transactions printed on banking reports now use "dd/mm/yyyy" as the date format.
Resolved an error encountered when canceling an invoice without a service record
This error occurred when creating an invoice, adding then removing a service and then trying to delete the
invoice. This error will no longer occur as the action buttons will be disabled when no service items are in the
service item list or in the add service item box.
Claim () Fund (®) Medicare
Error >
Services
Office ZED-8432 Date Item#= Description Save invoice(s) error!! Press 'Cancel’ button on Invoice Form to  Notes]
|JJ_ " " cancel the invoice!
Resolved performance issues caused by an Hl service outage
This fix prevents the Patient records from loading very slowly during the opening of multiple patient records
when the Hl service is down. The IHI check should now be run in the background for each individual patient
Office ZED-8436 | without slowing down the Ul performance.
Additional information has been added to the MHR Status section of the patient record and will display
when the IHI check is running and if the check times out it will update to display this information.
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Resolved anissue that caused a Patient's name to be cut off on the Patient Letter pick list.
In the Patient Pick List Dialog (Patient>Letters>Pick List) - Last letter of Family name was cut off due to the
font style.
Office | ZED-8480 |[Pick List
l} Carter Devall
[ Title From To Created CreatedBy  Bm Location |
Fixed Error 'Midnights not a valid time,' on the Waiting Times report.
Fixed an issue where an error was displayed when Midnight was selected as the End Time on the Waiting
Times report. Occurred when you select Daily Reports > Waiting Times > Select the End Time dropdown and
choose Midnight > Click on Print or Screen.
Report Critena
Office ZED-8530 (8) Detailed repart Entry Dat= [epemza 2| [oamamn =]
Group By  pipnd E1TeT cocumred b
Order By M‘h 6 ‘Midnight’ is nat 2 valid time. —Vl
() Waitng tmes by E | Details > > | i i
CPatient per haur i [ Send this error via Internet Copy ta Clipboard [ |
[ Attach a Screenshot image |
Aoptjattend (lat=r of) | ta | Admission time v
Resolved an issue that caused a patient's pronoun to disappear
Office ZED-8534 | Fixed anissue where clinic-defined pronouns (dropdown list management ) could disappear from the
pronouns selected for a patient.
Resolved a Booking Wait Time Report error and corrected the changes shown
The Booking Wait Time report will now display changes from the last edit made to an appointment.
Additionally, the report has been fixed to prevent an error when running the report for a single patient.
Booking Wait Times *
Star‘t - f_nd -
e 5 Period | 12/00/2023 12:00:01 AM~| 12/09/2023 11:50:59 PM~ |
Office ZED-8594 g Could not convartvar.an;gii?SFUn\mdasmng) into type Branch EALL v
: Staff AL v
oK | Details > > |
Send this error via Internet Copy ta Clipboard [] Patient |J””ES' Happy ‘ 1= patient
Exclude No Reason ()
Print I Screen ‘_ Close
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Resolved an issue with how the Date Details were display in Linked Appointments
The Linked Appointment Details dialog has been updated to use text formatting consistent with the rest of
the application. This resolved Linked Appointment Details - Date Details overlap.

Linked Appointment Details
Office ZED-8596
You have selected a linked appointment type for this patient ~Mame DOE  13/11/2002

appointment. Please enter the following information to Address
complete the linked appointment.

Original Appointment Details Linked Appointment Details Health Provider Availability

Date \Wednesday, 6 September 2023 IDate Wednesday, 6 September 20233t:| Wednesday, 6 Seplemberﬁ-l

Resolved issue with Patient Type details display in the Appointment and Attendance Details dialogs
The Patient Type in Appointment Details and Attendance Details screens no longer overlap the screen.

Appointment Details
Office ZED-8598

Date: Wednesday, 6 September 2023 Created by PD Simkiw Talia

r
Doctor  GRACE HERMAN on 06/03/23at 12:08 o cag Pull File Yes DOB 24/10/1982
Resource Fistin 31/01/2023 lastin 16/08/2023 I Type Patient Type ABC':I

Start Time Clinic | Branch 1 v|  Contact Details

status (O - Phone (H) 01000000 Work (W) 02 0000000
Mabile 0410 654815

Duration

An Assist Fee can no longer be used with non Assist able item
Office ZED-8657 | When setting a billing item as an assisted item that is not an assistable item, the Assisting Billing Options
screen is no longer displayed.

Resolved an issue with the Service date and Billing date range in the Assistant Service Report.
Office ZED-8658 | Fixed the date picker button for “To date” on the Assistant Service Report so that the date selected is
displayed in the To field and not the From field.

Fixed the layout of the reprint token message box.
Removed an incorrect line in the message displayed when reprinting an eScript token.

Confirm »
. Printed token will not be valid if the presaription has already been
Office ZED-8659 filed. If the patient requires a reprint of a repeat issued by a
pharmacy, the pharmacy that issued the repeat token will be able
1o

reprint a token for them. Would you ke to continue?

-
Reprint Token | Don't Reprint Token 3

Office will still run if the cancel button is clicked on the Login screen.
Office ZED-8772 | Fixed issue where Patients.exe would crash when Office was closed without logging in first (i.e. opens
Zedmed Office, then closes the login prompt to exit, without logging in).

Selecting F4 twice will once again bring up the last patient searched.
Office ZED-8777 |Fixed issue where if a patient is associated with more than one branch selecting F4 twice (or clicking on Last
button) did not open the last patient.
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Staff Username truncates to 10 characters automatically
Office ZED-7492 | The "Edit Staff Member" dialog (Staff tab in the Securiy module) now prevents users from entering
usernames greater than 10 characters in length.

Added an Ethnicity field to Zedmed Clinical
Capturing or viewing a patient's ethnicity details has been added to the Family, Social & Past History
information in Clinical.

Patient - Holloway, Mr Knut (He/Him)

Patient Details MNOK and Emergency Contact ~ Family, Social & Past History  Smoking  Alcohol  Other Clinicians
Miscellaneous

Clinical | ZED-8483

Occupation

sexuality  Unknown v Ethnicity cat British, nec: British; NORTH-WEST EUROPEAN &

Family History

Resolved Ul Issues in Clinical Reports
Clinical ZED-8544 | Fixed some minor issues with font sizes and labels being cut off in the Clinical reports, including Font Types
or Font Size and Labels being cut off.

Updated the Intramail Ul in Clinical
Clinical intramail buttons and icons have been updated on main dialog to match those in Office.

Clinical | ZED-8552

Fixed the Results Inbox Error: Unexpected end of command-line 2, column 1
Results Inbox has been fixed to prevent an error when retrieving results for all doctors on clinics with a large
number of doctors configured.

. Error occurred x
Clinical |ZED-8561
e Unexpected end of command - line 2, column 1.
[ Send this error via Internet Copy to Clipboard [

Enabled a configuration to limit attachments tab file size in clinical
Clinical ZED8574 | Added a maximum value in MB's for uploading of files to tabs in the summary views and set the default. This
can be found in the Global Options > General tab.

Turned on Icon captions by default in Zedmed Clinical
Encounter icon captions are now turned on by default for users logging into Clinical for the first time.

Clinical ZED-8595 Current Encounter - Duration: 00:00:02

0 B L DH Y AB & & &H

Problems Drugs Observations Referrals Immunisations Allergies Consumable Diagrams Templates Add Problemn  Del Problem  CDM  Calculators

Resolved a formatting Issue When Copying Clinical Notes to Letter Writer
Clinical ZED-8630 | Added a new Paste Plain Text option to the Letter Writer to allow formatted text such as encounter notes to
be copied and pasted into a letter without formatting.
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Introduced a Filter Feature for Merge Fields in Letter Writer
The Clinical Letter Writer now provides a filter function in the data toolbar, allowing for a quick look-up of a
field in the list of available merge fields.

=@
EE|ciceEe| O
s e e

Clinical | ZED-8633

J Fiter i
Data Toolbar

E Chnical Detais
& Treating Doctor

Resolved an access violation in module 'crs_client.exe' when closing Patients in Clinical.
Clinical ZED-8687 | Fixed an issue where an AV error was displayed in some cases after closing a patient file in Clinical where My
Health Record is enabled.

Resolved an issue with My Health Record auto-upload displaying errors at a test site
Clinical | ZED-8739 | The error occurred for patients with a hidden record and displayed a warning that has been fixed.

The Write referral button in HealthShare will now only be an option in Referrals.
Clinical ZED-8778 | Removed the"Write Referral" button from HealthShare address book search when opening the search
screen from the main toolbar in Clinical.

Removed obsolete Zedmed files and exe from the Installer/Upgrader
Upgrader | ZED-8614 X . X
The Zedmed Upgrader has been enhanced to remove obsolete files from client installations.

Zedmed v36.1.1

PDF viewer unable to view the document - Blank Document
Clinical | ZED-8668 |Fixed anissue that may prevent the viewing of older PDF files, especially those produced by scanning
documents

Zedmed v36.1.0

Zedmed v36.1.0 is a major release that introduces a modern theme, integration with accounting software including Xero and MYOB,
HealthLink SmartForm enhancements and pronoun and gender updates.

New Modern theme

No menus or layouts have changed, but you now have the option to use the new Modern theme or the existing Classic theme.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



File Encounter Results Reference Library Reports Tools Utilities Help

= R X ()

\
Open Patient ~ OpenFamily  Close Patient Waiting room | Results inbox v Address book Travel Batch letter To do list

Holloway, Andrea .

Holloway, Andrea JICurrent Encounter - Duration: 00:00:41

& e U S

Problems Drugs Observations Referrals Immunisations Consumable Diagrams Templates

(@) tnsetinesprasem |

Address: 5 Kingsley Gr,
BENOWA 4217
DOB: 26/12/1943
Age: 79 years
Medicare No: 49503503111
File No: 456
Hosp UR Ne:
MHR Status: Consent to Upload
Referrer: Dr Support Zedmed

G) RFE: | [ Use Coded RFEs |Management Plan

Summary Views

| Problems | Referrals | Resuits | Immunisations | Allergies | Images/ECG | Pregnancies |

Documents | Attachments | Measurements | Medications | Incoming Decuments |

History View

7 Include MHR Sort: |Medication Text « Oldest Encounter: 20/05/2021
L S h Billi s
2 1[2]13] V| 3| 8||Q Hey | Hia

Prescribed >

Current Medications L izard| Visible: | Last 10 Consultations v Include MHR

Regular Use
Paracetamol 500mg Coated Tablet 500mg [20] - TAKE 2 TID
Paracetamol 500mg Coated Tablet 500mg [50] - TAKE 2 TID AS DIRECTED

Intramail
12/08/2022 (Fri) 10:00am with Dr Phillip Davis at MED, for 4h 23m 10s
parental anxiety

PRN 15/07/2022 (Fri) 10:54am with Dr Phillip Davis at MED, for 16m 08s
Short Term Headaches
Non-current Medications 13/07/2022 (Wed) 11:21am with Dr Phillip Davis at MED, for 17m 45s
Stomach ache
20/05/2021 (Thu) 5:09pm with Dr Phillip Davis at MED, for 0m 20s
et Vicw Allergy: Crunchy peanut butter
Al\erg\es:lcm"d"y peanut butter @
Warnings: | Py
Recalls: | @

e The first time you open Office and Clinical after the upgrade, you will be prompted to choose a theme.
e You can have matching or different themes in Office and Clinical.
e You can swap themes at any time if you change your mind.

The first time opening Office - select Modern or Classic. To change -Themes > Modern or Classic.

1
2]
Appointment  Search  View Refresh WaitingReom Patient Bill Encounters RefDrs Close Extra

Management Reports Taols Practice Setup WP Setup  Utiities

-IHatcher, Danni - Reception Management ts
27 Jun (Tue) 28 Jun (Wed) 29 Jun Thu) e
14M o 0 0|
© Modemn ‘ Waiting Room
Appointments
4 Au o) 0 ol

Appointment Search View Refresh WaitingRoom Patient Bill Encounters RefDrs Close Extra

2 & = . o) Qs
” / - - - +} J
ey tn Branch 1 Hatcher, Danni s L
27 Jun (Tue) 28 Jun (Wed) 29 Jun Thu)|
e o] [ 0
O Classic .
7Au o g o Message of the Day
‘Welcome to Serenity S
Zedmed S/W Support
Tel: 1300 933 000
Fax: 03 9284 3399
= T After Hours: 0408 002 964
4 Month 4 Week 4 Day Day ﬁ Week b Month b 3Months B 6 Months b 3 M v

Today
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The first time opening Clinical - select Modern or Classic.

O Modemn ‘

Smith, Henry [E

Encounter Resuts Reference Library Reports Tock  Utiioes Help

Semith, Henry

Address: 12 varle st L
DUEBO 2830
DOB: 17/06/15:0

Medicars Mo 20513250241
File No: C22
Hosp UR No:
MHR Status: Consent to Upload

Tl e () et e

Home:
Work:
Mobile:
Oceupation:

@

e

Undefined Probiem

To change - Tools > My Options > Modern or Classic.

ile Encounter Results Reference Library Reports]

Utilities Help

pioprons

General | Drug Options | Document Handling | Fundtion Selections | My Health Record |

Defauts
Show Pathology Details Form
p
CRS Close Prompt
Show Audit Records
Froblem Quick Select
Patient Clase Prompt
Show Graph Values
Button Captions
Show Encaunter Button Captions

Problem Search Type

My Most Recent

RROO000RO

o) (3

VI Show s C

Ocassic [y

File Encounter Results

Reference Libary Rapons Teok Utiities Help

()

e

atient | WaitingRoom | Resulls Inbox

=

§iy

Address: 12 Wattle St
DUBEO 2830
DOB: 17/06/1940
Age: 83 years
Medicare No: 23513360241
File No: C82
Hosp UR No:
MHR Status: Consent to Uplozd

ST

Current Encounter - Duration: 00:03:09

L

Problems  Drugs Observations. Refemaly

[V]ACR Prompt

Show Prablem Criticality

[ Defauit IPC scaren to shaw Probiems / Symptoms Oniy
[ Default to viewing enhanced Resuls iew (PDF or RTR

S

Medications >.. wledication Text

Meaurements Summary View - Sort By [Type v
Default Waiting Room Order By [Attendance Time
Default Summany View Tab [Froblems v

Defoult Printer Settings [Local v

Show [Last 10 Consuttations | in History View

Default Template

Predictive Search (ICPC and Co v

i, WP

Document Tempiate [Re Letersomaors

o=

Undenned Problem

e e[
T

[cmwmm“

® Classic O Modern

)

Surgical Partners integration

Images (Zoom To)

Show et Dislag i Patent
Wrregnant

Mibreast reecing

[etite Sports Person

[age Greater Than | v | vears
¥ Has Recalls D Overcve

[¥Has Pending / Initial Results

- ,QM

Pathology | Gribbie.

=

Radiology | RADPLUS Radialogy
Use Clinical Billing Wizard

e} Ono @ site Defautt
[IBilling Wizard: Inform if No Matching Attendance of Encounter Cic
Use Chranic Disease Module
O ves ONo ® Site Default
Consuttation Timer Alert

[use Consutation Alert [ geep at End Time

7 Heip

o oK X cancel |

Surgical Partners is a financial management platform that integrates Zedmed with accounting products including Xero and MYOB.
This allows you to use the financial information in Zedmed for a range of financial applications from debtors' management to banking
and payroll. This functionality is enabled by registering with Surgical Partners who will configure Zedmed to send the required
financial data to your accounting software each night.

To learn more, visit https://surgicalpartners.com.au.

Zedmed v36.1.0 Updates (part of the v36.0.0 release)

Clinical

ZED-8328

Implemented a new PDF tool to view results and scanned documents in Clinical
Removed the requirement for Adobe Reader from Zedmed. PDFs can now be viewed (both when embedded
in aresult and when attached from a scan) without any external PDF viewer installed.

Office

ZED-8252

Access Violation error resolved when deleting an Appointment Type

Fixed an error that occurred when attempting to delete an appointment type from Office

Office

ZED-8360

another attempt.

Corrected the Message/Buttons displayed when a Tyro Easyclaim has been canceled.
The message displayed when a user canceled a Tyro Easyclaim has been resolved and the form now allows

Office

ZED-8423

Deleted prescriptions are no longer displayed on HealthLink Forms.
Deleted prescriptions were still showing up as selectable options in the HealthLink SmartForm.

Clinical

ZED-8452

The Encounter Timer no longer disappears when resuming an encounter.
Fixed an issue where the Clinical Encounter timer would no longer be displayed after resuming an existing
encounter.
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Updated the Appointment and Full day icons for the Modern Theme.
Office | ZED-8481 |Updated theicons displayed on the Appointment Grid for Appointment and Full Day menu bar options so
they are no longer similar to Zoom In and Zoom Out icons.

Zedmed v36.0.0 HealthLink SmartForms enhancements

For new users, please follow the Zedmed SmartForms installation guide.
For existing users, please follow the manual upgrade guide.

Improved the names used for attachments in SmartForms
Each HL7 results file can include several sections, and Clinical Results Inbox displays them as follows:

1. Result View tab.

2. Enhanced View tab - HL7 file includes only 1 additional part.
3. Enhanced View #N - HL7 file includes N additional parts.

4. 2 and 3 are not always present, depends on HL7.

Results in HL7 files added as attachments to a SmartForm will be named as follows:

1. <HL7 FResult Name> (Result View) tab.
2. <HL7 FResult Name> (Enhanced View) tab - HL7 file includes only 1 additional part.
3. <HL7 FResult Name> (Enhanced View #N) - HL7 file includes N additional parts.

Clinical | ZED-8267 2 and 3 are not always present - depends on the HL7.

Requested Information gk Diagnostic Reports / Patient Documents [ Browse for Patient Document || Browsa for Local File

Dermatology

Altach file from EMR supports: gif, htmi, jpeg, doc, docx, pdf, txt, i, tiff
Attach file from Computer supponts files that end in types: doc, docx, gif, him, himl, jpeg. Jpa. pdf, rif, tif, tff, ta

Caution: larger attachments may take significant time lo preview

Attachments | Reports

M ropcita alecied [N I Fammmans L s

Ho fies aftached O] | 1300772023 Attachment Bt 1KB
) | 1200772023 Colorectal Cancer Structured " “eg

Medications, Allergies, Pathology Report (Enhanced View

Alerts A #1)

2 T ecified O 12/07/2023 = Colorectal Cancer Structured himl

Pathology Report (Enhanced View
#2)

. . : (] | 120772023  Colorectal Cancer Structured pdi
Medical, Social and Family Pathology Report (Result View)
SRRV 07 | 1200772023 | Documents RTF fils ' G T 20 K8
[ | 12/07/2023 Images’/ECG bt 1KB

B0 @ @@

Zedmed's Healthlink SmartForms integration is now upgradeable
The Healthlink SmartForms service installer has been updated from an MSl into an exe file (as used by other
parts of the Zedmed software) so the software is now upgradeable.

Clinical | ZED-8292

Healthlink SmartForm will display 1 attachment for HL7 files with 2 records

The functionality of Zedmed's HealthLink SmartForms integration has been improved. HL7 results that
include PIT segments in addition to FT segments will be included as one attachment (as it is done in Clinical,
Results).

Clinical |ZED-8332
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Clinical | ZED-8379

The 'HealthLink Create Referral' button can be removed from the Encounter toolbar
Doctors can now remove the 'HealthLink Create Referral' button from the encounter toolbar. This is done in
Clinical > My Options > Function Selections tab > Show the HealthLink button.

[Current Encounter - Duration: 00:05:49

FoYD L DHBAB R

General Drug Options Document Handling Function Selections  hy Health Record h

My Options

41 5how the Problems button

[ show the Preseriptions button
[ Show the Observations button
[£] show the Referrals button

[ show the Immunisations button
4] show the Allergies buttan

[ show the Consumable button
[ show the Diagrams button

[ show the Templates button

[ show the Add Problem button
[] Show the Delete Problem button

[ Show the Pregnancy button

[ Show the Chranic Disease Module button <] @& Indude MHR

[1Show the Clinical Calculators button
[ Show the Capture button

[~ show the Histories button

[ show the Spelicheck button

[] show the Backdate button

[DShdw 1he Create New HealthLink Refe ral button ]

Clinical | ZED-8387

Resolved a scenario where a staff name could appear as the provider in a SmartForm

Resolved an issue that caused the provider details ( Referred By name) in a HealthLink SmartForm to be
populated with a staff member's details instead of the provider's details, when the staff member's ID was the
same as the doctor's code.

Zedmed v36.0.0 Office & Clinical enhancements

Clinical |ZED-7979

New Pathology & Radiology referral templates added to the Clinical Addressbook for:

e Australian Clinical Labs Comprehensive Carrier Screen Request = PathologyClinicalLabsCCS
e Queensland Ultrasound for Women = RadiologyQUFW

e Sydney Ultrasound for Women = RadiologySydneyUltrasoundForWomen

e Vision Radiology = RadiologyVisionCardiac

Laboratory Details

D Use As Preferred Laboratory
[ IPRS PP Fia i olo oy clbourmeRadChinic DL Command Line |

RadiologySydneyUltrasoundFarWomen a "

RadiologyToowombaDiagnosticimaging DL Directory D'

RadiologyUniRad UL Directo

RadiologyUniRadiology o D'
RadiologyUniRadiology2
RadiologyVictorianMedicallmagin

Lab Communications

Vertical Offset{mm)

Update Details fro 7 Help W 0K X cancen

RadiologyWesternimagingForwomen ¥

Pronoun field added to Zedmed Office & Clinical
Added support for specifying preferred pronouns to Zedmed. Pronouns can be set in either the Office or
Clinical Patient Details forms and are displayed in the following locations.

e The selected pronouns will appear when chosen in the patient record Pronouns drop-down.
e Enabled at practice and branch level.
e Additional pronouns can be added in Practice Setup > Drop-down List Management> Pronouns.
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Office/
Clinical

ZED-1674

Checklists
Instrument
Procedure Type
Product Category
I Pronouns

¥4 Drop-Down List Management

Appointment Cancellation Reasons Description

He/Him
She/Her
They, Them

Prosthesis
Stock Movement Reason

Add Value | | Delete Value

Fladgive Q& Omep Q3 [Jers

[m] x

Pronouns display:

e The header of patient details summary in Clinical.
e Title of patient details in Clinical.

e

7
Open Pabient Open Family

Jones, Mr Happy (They/Them) n

Jones, Mr Happy FWThum}

e Patient record tab in Clinical.
e Title of patient details in Office.

B Tonee Yaony [They Thern ]

AccEnquiry Attend”  ©N  Letters  Clinical information  Print  Quote

Receipt Waiting Room  Appointments  Extras

Patient Details [ Personal ; P I
I g T 1 Family Mame | Jones |
Further Details *

. I -
Recalls Given Name | Happy | Initial
Notepad Preferred Name | | e
ELEERY Title !M' Sexat Bith (M
ool Pronouns !Thc;.-"l'hcln ]

Practice
Filew {22

Hosp. UR No
L
Usual Branch  Branch 1 (22)
First In |

Type

[

Pronouns & Sex at Birth
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¥4 Jones, Happy X
AccEnquiry Attend  Bill  Letters Clinical Information  Print  Quote Receipt Waiting Room  Appointments  Extras
Changedi.Gender *toSex at Birth" Padice: —————————
Civéngietithe "Gender” fleld to Feac irthinOffice. Cliiaical and the 'mmve—pgﬂ L Lt
. @ Ehe enaer r1ie (0] calan e € UTHItY:
Office ZED-8194 Recalts Given Hame [Happy Tnitial Hosp. UR No | | L¥niul Warnings
| Notepad Preferred Name | | Former Usual Branch | Branch 1 (22) ~
>§m§t§creenshot above. Title Ml I Sex at Birth ‘l:!rq First In | Last In
Messages W ﬂ Type [ Status | Current |2
Date of Eirth Age 58 Family
. o . . s | p3he/Her .
Fthnicity is available/inthe Patient-Merge utiljty * Jones, Happy (22) v
Office ZED-8202 |Ethnicity is now available in the-Patient-Merge utility-when-m: gingrahuplieate records. It is displayed when
Suburb [ISABELLA PLAINS
AdvanCEd IS SEIeCt%elud Contact Branch Default not set) = Payers
Method
@ = - ——————————————
%o [Mobite || ] Fund  No fund set for this patient
Do Not Send SMS [ | Default Appointment SMS [:] = s Claims
Changed the default doséféPPrevenar 13 Childhood immunization
Referrals
Updated the dose from m&f@mﬂzﬂnonm Pagumococcal (JLSVPCV) Childhood Scheduledtmmunisation
Veteran | | & | = e
Childhood Immunisation Schedule boa
Natiul_'ba_l Immunisa_tiun _Prog(all} Sc_hedule - Jul)_' 20_20 :
Vaccine Brand/Vaccine Date Batch Comment Dose Doctor Add... |
» 12 Months ~ [
MME 1 Modify... | ]
Clinical | ZED-8215 AeMency ) |
13vPCV 3 Delete.., o
12 Months - in SA as Dose 3 OR ATSI only as Dose 4 I—
Tenk 3
“*Transferred to ditferent card, Old card quoted,**
| petete || mint || patientvertication | | Fing Cose || cancel
Added the Service date to the Claims screen and Claims Report
Claims Status Ul and report now show the date of the service against each item in the invoice.
¥4 Claim Status
Refresh Default View Expand All Collapse All Void Rejected Invoices
Claims  payments
Office ZED-8326 ; :
From [11/07/2023 [E~ | @ |AlSubmitted ClaimTypes | Branch <All> ~| Dodor |<All> ~ | Claim ID
To 18/07/2023 [~ | O Mot Submitted Status  <All> w| patient [aN Find Patient Clear |
O Irw.fServi(e,fJ\i;ls;or Status Patient CQutstanding Paid Doctar Claim ID Medicare
B[ Inv103015 18/07/2023 WITHME...  Simkins, Talia $331.50 S0.00 Augustus Eason 211307 211307
1186 4/07/2023 Unpaid 5110.50 50.00
16 11/07/2023 Unpaid §110.50 s0.00
116 18/07/2023 Unpaid 511050 50.00
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Office

ZED-8370

Replaced the PDF viewer for the "View Claim" button in Account Enquiry
Updated the application used to view PDFs in Office for Claims. Viewing a claim from the account enquiry
screen is now significantly faster.

4 Account Engui

Patient  Simkins, Talia

Payer Simkins, Talia w Recalculate
Curmr 331.50 30+ 0.00 60+ 0.00 0.00
Transacton
Invoices Data Patient HIC  CLM# B Dr Value Qutstanding
>-I 103015 18/07/2023 SIMKINS, TALIA P4 PDF Viewer

“ Save s [Eiprint (5 Puint (with printer selection) | - FtWidih | FitPege J® ZoomIn /= Zoom Out

Patient Claim Consent and Declaration

Location ID: SAP02482 Reference: 211307

Zedmed v36.0.0 Office & Clinicalupdates

Important update.
Clinical ZED-8286 Reduced the flicker on the Results Inbox display list
Results Inbox module has been reworked to prevent flickering as users action results.
Resolved an error that occurred when merging patients with the same SMS message
Office ZED-5462 When merging patients that reference the same SMS message, Zedmed Patient Merger will now only move one copy the message to the merged record. Previously it would
report an error and abort the merge process.
The Last (F4) Button now works in Appointments
While searching for patients on the Appointments Ul, selecting the Last F4 button now selects the last opened patient in the appointment search dialog.
| <Al Doctors> | IRCIINCS
Tue Hatcher, Danni HEDRICK WARREN HERMAN, GRACE Davis, Phillip
gau 0 0 O o
30|
45,
g [ 5 O 9
15]
30 30| 22 Jones, Happy
45 45 17 Janes, Marrianna.
Office ZED-5494 10 | ° i ] °
15] 15| E 15‘ 15]
30| 30/
| Search for Appeintments L
5 s =
PERE 0 Patient Jones, Happy Drna —]
75| 5| from (s | [ To o204 3| u
2 = Date Time  Duration Doctor Resource Granch Status  Notes o
= |+ T Tue 18/07/2023 9:30:00 A 10 PD MED  Active I
1 Zm o 0| N
15
30
45
PEY [ 0 B | |
15| < >
30,
Print List Delete Refresh Close
s
e
Office ZED-7111 The Delete button in Staff Maintenance>Apps Access no longer causes an Access Violation
The Delete button on the staff permissions maintenance dialog, App Access tab, will now remain disabled until a selection has been made to prevent an error.
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Resoved Error Data too large for variable [[TEM_CODE]. Max len = [8], actual len = [9] when running AMA Fee Load
The Load MBS/AMA Item By Criteria option now works when the Load from AMA file checkbox is selected and an AMA load fee file is used. AMA fees will now be loaded as
long as the corresponding MBS item already exists, a report is displayed at the end of the import listing the items that could not be imported.
Load MBS/AMA item X
(®) Load MBS/AMA Item By Criteria
 Update Existing MBS/AMA ftems
Loading Criteria
Item Number
Category | i
Group -
Sub Group
Loaded ltems
Item Mumber Commence Date
Short
Description
Full
Deseription
Office ZED-7982
Number of Items Loaded : ] Continue Without Short Description
Load Item I E Load from AMA file | Clase Cancel
Office ZED-7983 Resolved Error - Param [NEWSTARTDATE] type changed from [ftSQLTimeStamp] to [ftDateTime] running AMA Update Fees
The Update Existing MBS/AMA Items with the Load from AMA file option selected will now run without error and enable the update AMA items.
Office ZED-8233 Statistics report - Referral Doctor criteria now correctly lists all address book entries (not just referral doctors)
Referral Doctor criteria in the Statistics Report will now only list Referral Doctor contacts who are set as Available.
Office ZED-8247 Resolved Error "Zedmed Office was unable to load the OLE object file" when you Select or Preview an archived letter
Fixed the issue with an error being displayed when selecting or previewing patient letters that have been archived.
Clinical ZED-8248 Resove-d Error Type ID Mismatch' when m-1port|ng.CDA!etters ) N ) ) ) )
When importing HL7 messages that contain XML files with a namespace prefix, Zedmed Clinical will report a more accurate error instead of returning "Type ID mismatch".
Office ZED-8362 Resolved an Intramail error in Sent Items
Fixed an error that occurred when viewing sent items in office intramail when the To: or CC: fields contain a combined total of more than 1000 characters.
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Office

ZED-8367

A double booking Patient's name will no longer change when editing the appointment.
Modifying an appointment by selecting it from the appointment selector (appointment 'Details' context menu option), no longer displays a different patient in the
appointment selector at the end of the process.
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